



















This document is divided into three sections: an introduction to the University’s approach; general guidance in response to the WCAG2.1 legislation; detailed guidance and subject-specific advice. 
We expect all staff to be aware of, and follow, the general guidance given in this document to produce and use digitally accessible resources in all courses. Please use the rest of the documents as a reference for specific issues or subjects.
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No two people learn the same. However, there are many things that can be done to improve digital accessibility and make sure that the learning experience is easier and more accessible for everyone.

[bookmark: _Toc45535371][bookmark: _Toc45535578][bookmark: _Toc45538305][bookmark: _Toc45538441][bookmark: _Toc46219771][bookmark: _Toc46220708][bookmark: _Toc46220823][bookmark: _Toc46930376][bookmark: _Toc47087209]The journey to accessible materials
It is important to note that the guidance here, and the support which the University is providing, is one step in the path to providing fully accessible content. As technology improves, it will become easier to produce fully accessible content. Given the situation as it stands, and the impact that COVID-19 is having on teaching, the University is committed to making materials as accessible as possible, regularly revisiting and reviewing these guidelines and support given to staff.

The University has been working on how to make learning materials accessible for some time. The University has accessibility statements for all webpages, including specific accessibility statements for Moodle, Core HR, Mahara, MyCampus and the Help Desk. All University owned digital platforms will have accessibility statements by 23rd September 2020, in accordance with the regulations. These accessibility statements detail how accessible the website or platform is; which areas are not accessible; how the platform was tested; what is being done to improve accessibility; and who to contact if you are experiencing accessibility issues, or require an alternative format.
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This document provides guidance on how to provide transcripts for video; information regarding 3rd party resources; and general information on how to make your resources accessible. This is in response to legislation from 2018 which states that there is ‘the requirement to make a website or mobile application accessible by making it perceivable, operable, understandable and robust’ as well as providing an accessibility statement demonstrating compliance with the regulations and to provide an alternative format of content on request. New legislation coming into force from 23rd September 2020, states that all recorded video must be captioned/have a transcript (apart from certain exceptions, like live video or video which is an alternative to text). 
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If you require support or have any questions, then please take a look at the website or take a look at the Additional Resources section at the end of this document. If you feel that something is missing from the website, then please get in touch with Information Services. If you have a question regarding assistive technology or particular disabilities, then please contact the Disability Service.
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[bookmark: _Toc46930380][bookmark: _Toc47087213]General guidance for all staff
All content should be accessible, to achieve this there are a few simple recommendations that you should consider.
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The following guidance in this section is designed to help compliance with the WCAG2.1 AA legislation which is based on four design principles: perceivable, operable, understandable, and robust. All digital content must be compatible with these principles; more detail can be found on the Gov.uk website.
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Use SCULPT:  Check each aspect listed in this infographic when creating your materials:
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SCULPT covers the six basic things to remember when creating accessible content and was created by Helen Wilson from Worcestershire County Council. It is used here under a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.

The University of Glasgow also has advice regarding how to approach creating accessible content, adapted from the guidelines above, on the University’s digital accessibility webpages.

[bookmark: _Toc45535381][bookmark: _Toc45535587][bookmark: _Toc45538314][bookmark: _Toc45538449][bookmark: _Toc46219779][bookmark: _Toc46220716][bookmark: _Toc46220831]Further check for all learning content 

[bookmark: _Toc45535382][bookmark: _Toc45535588][bookmark: _Toc45538315]Check document structure
· Use proper headings  in all documentation
· Do not rely on colour as a navigational tool or to differentiate items
· Make sure that content appears and operates in unsurprising ways
· Be aware that your materials must be compatible with different technologies (such as plug-ins or screen readers like NVDA)

[bookmark: _Toc45535383][bookmark: _Toc45535589][bookmark: _Toc45538316]Check how you have used images
· Do not rely on images to convey meaning as these cannot be read through text-to-speech
· Provide text alternatives for non-text content
· Make sure that alternative formats are available (easily achievable through Blackboard Ally for supported file types)

[bookmark: _Toc45535384][bookmark: _Toc45535590][bookmark: _Toc45538317]Good practice to consider
· Give users enough time to read and use the content, as those with learning difficulties or conditions like autism or ADHD can struggle to ingest large amounts of information quickly
· 
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What are the regulations?
The 2018 Digital Accessibility Regulations require that, from 23rd September 2020, all ‘time-based media’ (video and audio) must either provide a transcript or captioning or both (video only). Media published before that date is exempt.

Transcripts and/or Captioning
The University has agreed that we will provide automatic transcripts, i.e. machine-generated transcripts, for all video recorded via services that Information Services provides, primarily Zoom, Echo 360 and Microsoft Stream.
· There is no legal obligation to improve the quality of these transcripts which are claimed to be between 75 - 90% accurate, although strong anecdotal evidence suggests it is less than that
· Ideally corrected transcripts and captions should be provided; however, this will depend upon time and resources available
· We recommend where possible, a link to a subject-specific online dictionary is provided (e.g. using the University’s online reading lists via Moodle), as well as an additional glossary of any subject specific / technical terms that are used in recordings

We recommend that staff assess the need for accurate transcripts and/or captions with the following considerations in mind:
· The impact accurate transcripts and or captions will have on student learning
· The time and resources available to edit automated transcripts and include captions
· The delivery model of the course the recording belongs to e.g. Online distance learning or on-campus
· The likelihood of the recording being used in future years
· The length of the recording
· Is the content already available in accurate written format e.g.,
· assessment information
· a written script to produce the recording
· written notes to support the resource
· An edited transcript should by understandable and retain the meaning of the recording
· An expert in the subject area will have to check the accuracy before publishing
· Where possible, technical terms should be included in text form in the e.g. PowerPoint slides

Please note:
· Live video less than 14 days old is exempt from the legislation. 14 days is the maximum amount of time given, and if a recording of a live event is made available after the event then a transcript and/or captioning must be provided as soon as possible
· If a document is used in the video (PowerPoint, Word or similar alternatives), then an accessible version must also be provided
· If the media is replicating or summarising existing text-based content (e.g., handout or lecture notes) and it contains no more information than the text then it can simply be labelled as such and does not require a transcript

Transcripts and/or captioning means not only having written text of what is being said, but also a description of anything that is happening on the audio file, for example, music playing or wind blowing through the trees. In most cases this may not be an issue, but in some instructional videos it will be.
[bookmark: _Toc46219781][bookmark: _Toc46220718][bookmark: _Toc46220833]


[bookmark: _Toc46219782][bookmark: _Toc46220719][bookmark: _Toc46220834][bookmark: _Toc46930383][bookmark: _Toc47087216]Using 3rd party resources

What are the regulations?
The 2018 regulations (which come into force on 23rd September 2020) place the legal obligation of compliance, regarding 3rd party resources, on the public sector body. 
This means that if you have not paid for, or not developed, the 3rd party content, then you are exempt from making sure that 3rd party resources are compliant. 
However, if you use 3rd party resources as an essential/key resource or material, even if you have not developed or paid for them, then you – as the provider of these materials in the capacity that you are using them – are responsible for ensuring that the 3rd party resources are accessible, as specified under the ‘reasonable adjustments’ section of the 2010 Equality Act. This includes external websites, journals, videos, etc.
If you expect all of the students on the course to consume a particular 3rd party resource (i.e., it is a core resource or essential reading/viewing) then you should make sure that it is accessible or that you provide an alternative if it is not. However, if it is just an additional resource – and you are not expecting all of your students to engage with it – then you are not obliged to guarantee that it is accessible, although we would recommend that you do as good practice.

Video Content
When providing a video, it is important to note when the responsibility is on you to make sure that it is accessible.
· When the video is not owned or paid for by yourself, or the University, then it is 3rd party content which you do not have control over and therefore is exempt from the legislation around providing a transcript and/or captioned videos but under the Equality Act you have to make reasonable adjustments to make sure that it is accessible. As you are unable – due to copyright – to amend the 3rd party video if it is not accessible, then we recommend that you do not use it without providing an alternative
· If you have created a video yourself then you own the copyright and you are responsible under both the 2018 digital accessibility regulations and the 2010 Equality Act to make sure that the video is accessible (see sections above on making accessible recordings)
· If there is a performance video (such as from the Box of Broadcasts) which the University subscribes to (i.e., pays for) then you can only alter the video for the service of a disabled person – you cannot distribute this altered accessible video to all of your students, as this would breach performance copyright law

Other 3rd party content
· If it is a paid for service (such as a particular platform that is used by your students), then you are responsible for making sure that it is accessible
· If you have content which you do not rely on for your course or is not essential (such as ‘Additional Reading’) then you are not responsible for any external links, however, it is good practice to make sure that these are accessible or to provide an alternative if they are not

Linking to external content that is not currently accessible
There is information in the accessibility statements provided by the University that highlights that the University of Glasgow is not responsible for any external links, such as:

‘Our website contains third-party content. We do not have control over and are not responsible for the accessibility of this content, but we make best endeavours to work with the third party to improve its accessibility. This may include:
•	Links to non-University of Glasgow websites
•	Content/functionality on our website
•	Content hosted on other websites, such as social media sites.’

If the 3rd party content that you are using is not a relied upon material for your course/website/platform (such as ‘Additional Reading’ or ‘Additional Resources’), then you are not responsible for whether these links are accessible. However, again, it is preferable to make sure that any additional resources are accessible. Content should, in principle, not be used if it hinders or decreases the functionality of the public service offered on the website or mobile application concerned.

Copyright law may prevent you from making an external resource accessible
The existing copyright accessibility exceptions permit copying and adaptation of content for a particular person with accessibility needs only. They do not permit copying in anticipation of a person with accessibility needs or for accessibility purposes more generally.

Copyright law reserves the right to re-use and adapt content to the rightsholder. Copying and adaptation of content can only be done with the permission of the rightsholder usually in the form of a licence or by using copyright exceptions that are outlined in the copyright legislation – described here - https://www.gov.uk/guidance/exceptions-to-copyright.

Accessibility Statements
Accessibility statements have to be created for our digital platforms. As above, if you are using a website or a platform that you have developed, then you have to make it clear that it is compliant with the accessibility regulations. If you are using a resource that is not compliant then you have to clearly state where it is not compliant in a statement provided to those who are using it. This only applies if you have created a platform (such as a website). 

Although you do not have to create accessibility statements for your courses or resources, we would recommend that when linking non-accessible 3rd party resources (such as in ‘Additional Reading’ lists) that you clearly signpost to students that the following resource is not fully accessible and that you are aware of this. We would encourage you to point your students to alternatives. You do not have to signpost this to students but we would strongly urge you to as best practice and to make your course as inclusive as possible.
Summary
· If you link to or use any 3rd party files or resources, check that they are accessible using the guidance in this document
· If you have created the content, you are responsible for making sure it is accessible
· Videos which are not created or owned by yourself or the University may be protected by copyright and so cannot be altered – do not use these resources
· Any free platforms included as an essential part of the course has to be checked
· We would recommend signposting to your students which resources are not fully accessible


[bookmark: _Toc46930384][bookmark: _Toc47087217][bookmark: _Toc46219783][bookmark: _Toc46220720][bookmark: _Toc46220835]Detailed guidance and subject-specific advice

[bookmark: _Toc46930385][bookmark: _Toc47087218]Making accessible recordings – advice for staff 

Why make accessible recordings?
Providing transcripts and or captions of recordings can have a positive impact on learning for all students by:
· Making recordings more understandable for students
· Enhancing the learning experience for students whose native language is not English
· Improving flexibility of learning - captions allow recordings to be viewed in an environment with no or poor-quality audio
· Providing searchable recordings – some transcripts allow users to search for keywords and jump to the place in the video which will start playing where that word appears
Requirements
The 2018 Digital Accessibility Regulations require that, from 23rd September 2020, all ‘time-based media’ (video and audio) must either provide a transcript or captioning or both (video only). Media published before that date is exempt.

The University has agreed that we will provide automatic transcripts, i.e. machine-generated transcripts, for all video recorded via services that Information Services provides, primarily Zoom, Echo 360 and Microsoft Stream.
· Ideally corrected transcripts and captions should be provided; however, this will depend upon time and resources available
· We recommend where possible, a link to a subject-specific online dictionary is provided (e.g. using the University’s online reading lists via Moodle), as well as an additional glossary of any subject specific / technical terms that are used in recordings

Definitions
· A Transcript is the text of the spoken words and non-speech audio information in the recording
· Captions appear on the screen as the video is being played and are the text of what is said and a description of any sounds that are important to the understanding of the content. Captions can be open (always there) or closed (toggle on/off)
· An Audio description is a form of narration used to provide information surrounding key visual elements in a media work, typically placed during natural pauses in the audio, and sometimes during dialogue if deemed necessary

Before recording
· Consider the 7 principles of remote and blended teaching  and if content if can be delivered in an alternative format, for example Moodle Book or by H5P Course Presentation
· Review the accessibility of any slides or documents you plan to use in your recordings by using built-in or online accessibility checkers or Blackboard Ally
· Make changes where required to improve the accessibility of the resources
· Consider the positioning of the microphone e.g. is it close enough, is it rubbing against your clothes etc.
· Consider background Noise -Try to record somewhere where background noise is low
· Use a good quality microphone as this can improve the quality of the auto-generated transcripts
· You may wish to consider creating a script
· Further resources can be found in the Appendix (add link later)

Choosing a tool to record
Decide which tool you will use to make your recording. The University supported systems that will provide auto-generated transcripts are:
· Echo360 – is available in many lecture theatres and can be used on a personal device. Auto-generated transcripts are generated for any recording that is published to a class
· Zoom – University of Glasgow licensed. Provides auto-generated transcripts generated and provided to students along with the recording
· Microsoft Teams – Recordings automatically are uploaded to Stream. Auto-generated Transcripts are created alongside the video. Student access the video via office 365

For each system  
· Transcripts will auto scroll to the video playback
· Transcripts can be downloaded producing .vtt file which contains the transcribed text along with timing information of its location in the recording
· Transcripts and closed captions can be enabled or disabled during playback

There are many other tools that can be used to create recordings that will generate auto-transcripts. Staff are free to use these tools to generate accessible resources though support may be more limited.

Accuracy of video auto-generated transcripts
The accuracy of auto-generated transcripts and therefore their usefulness will vary depending on several factors including audio quality, pace and volume of the presenter, and the number of subject specific technical terms included in the presentation.
· Information on how to improve the quality of auto-generated transcripts is under development and will be made available to staff on the Digital Accessibility  and the Glasgow Anywhere web pages
· To try to manage student expectations, information on accuracy of auto transcripts and guidance on how to use transcripts and or captions will be provided to students

Editing Transcripts and providing Captions
· There is no legal obligation to improve the quality of these transcripts, which are claimed to be between 75 - 90% accurate; strong anecdotal evidence suggests it is less than that
· Legal advice from JISC is that some transcription is better than no transcription.
· Provision of edited transcripts and captions can improve accessibility and usability of the recordings, although it is recognised that doing this can be time consuming.  There is a balance to be struck between taking the time to provide accurate transcripts and/or captions and making the recordings available to students in a timely way

It is important to note that even when professional transcription services are used, staff who are experts in the subject area will need to read and edit the transcript to ensure accuracy.
[bookmark: _Toc46930386]Guidance on how to access transcripts for recordings created by other staff will be created.


[bookmark: _Toc47087219]Alt text for images (including complex images)

· If an image is decorative (i.e., they are there for purely aesthetic reasons) then it does not need alt text, instead the ‘Mark as decorative’ box can be ticked in the alt text tab when using Microsoft Office
· If the image conveys content, it should be given alt text
· Specificity is key: be descriptive but concise
· The amount of information included is obviously up to the content creator, but a good rule to go by is to think what meaning the image has and how that would be conveyed by text if it was not there
· Good alt text is be heavily dependent on the context in which you are using the image, and on the context of the image itself
· Do not include ‘picture of’ or ‘image of’, etc., in an alt text-box as it is either already assumed that the alt text is describing an image, or the screen reader will have already identified that the alt text is referring to an image
· If the image is complex and cannot be fully described in the alt text-box, then a longer description should be given somewhere else which is pointed to in the alt text-box, along with a simple indication of what the image is

The examples below illustrate why the image is being used and what the image is supposed to convey:
Example 1: An image in a University prospectus: ‘A picture of a student’ vs. ‘An undergraduate medical student working on their Level 2 exam.’
Example 2: An image of a graph given in a study: ‘A graph about media engaging with the Iraq war’ vs. ‘A graph detailing the percentage of Iraq war media sources in the US: Analysis of media coverage during the Iraq war was by no means universally objective. In fact, it's clear that coverage was overall pro-war with American news sources being slightly more pro-war than sources from outside the US. Neutral coverage came in at 26%, while a minority of sources were determined to be anti-war. Only 3% of American sources fell into that category.’
Example 3: An image of a peacock in a biology textbook: ‘A peacock’ vs. ‘A male peacock head. It is metallic blue on the crown, the feathers of the head being short and curled. The fan-shaped crest is made of feathers with bare black shafts and tipped with blush-green webbing. A white stripe above the eye and a crescent shaped white patch below the eye are formed by bare white skin. The sides of the head have iridescent greenish blue feathers. The back has scaly bronze-green 	feathers with black and copper markings.’

[bookmark: _Toc45535386][bookmark: _Toc45535592][bookmark: _Toc45538319][bookmark: _Toc45538451][bookmark: _Toc46219784][bookmark: _Toc46220721][bookmark: _Toc46220836][bookmark: _Toc46930387][bookmark: _Toc47087220]Charts/Graphs

A text description of the chart/graph must be provided; in some cases, a numeric table replicating the chart/graph data can be used as well.

· Different information and values can be indicated through different textures, differences in line style, text in graphs or different shades of colour, rather than simply different colours which is not accessible
· Do not convert tables of data into images, use an actual data table instead
· Instead of an alt text box for a complex chart/graph, 
· provide a text summary and a properly coded data table near the chart 
· OR provide a two-part alt text, with the first part in the alt text-box itself giving a short description of the chart/graph (and indicating where the longer, second part is) and the second part being a longer description which should be a textual representation of the essential data conveyed by the chart/graph and is located outside of the alt text-box (for example, an extra slide on a power point or a note on a document, or even a paragraph near the chart/graph)
· Bear in mind the different types of information that a chart/graph may be demonstrating, such as categories of data, trends, maximum and minimum values, etc.
· Make sure that students are aware that this information can be explored through other ways, such as Desmos, which is an online screen reader-accessible graphing calculator, which can also produce tactile diagrams
· You can deliver the information from a chart or graph in other ways, such as creating a video, talking to students in-person, or providing a tactile alternative if appropriate


[bookmark: _Toc45535387][bookmark: _Toc45535593][bookmark: _Toc45538320][bookmark: _Toc45538452][bookmark: _Toc46219785][bookmark: _Toc46220722][bookmark: _Toc46220837][bookmark: _Toc46930388][bookmark: _Toc47087221]Tables

· Use table headers so that screen readers are able to identify different columns and rows, and so that users are able to tab through the document
· Avoid blank cells as this can cause screen readers to think that the table has ended
· Use a simple structure
· Do not split or merge cells
· Remember to add alt text to the table
· There are different ways to format accessible tables using different types of headings, depending on the function of the table



[bookmark: _Toc45535388][bookmark: _Toc45535594][bookmark: _Toc45538321][bookmark: _Toc45538453][bookmark: _Toc46219786][bookmark: _Toc46220723][bookmark: _Toc46220838][bookmark: _Toc46930389][bookmark: _Toc47087222]Maps – recommendations for best practice

Under the digital accessibility regulations, maps are excluded unless they are part of a service, however, it is recommended (especially in keeping with the 2010 Equality Act) that you try to make all of your resources as inclusive as can be reasonably expected.

· If the map helps users find a service you offer, you must provide directions another way; through including text-based directions or a link to text-based directions
· When using a static image, use an alt text box
· An embedded map alone is not screen reader friendly
· Embedded maps should have a descriptive heading (which is then linked to the map site), as a screen reader will tell the user that the heading is a link
· If a map is being used to show landmarks, describe the landmarks and their locations in a list or paragraph
· If using a map to display multiple locations, provide these locations in a text list too
· If a map has colour-coded areas, make sure that there is sufficient contrast between the text and background and that the colours used are appropriate for those with colour-deficient vision – a good test is to see if the map is still usable in black and white
· Keep maps consistent and simple in style
· Google Maps provides guidance for accessibility when using their platform

[bookmark: _Toc45535416][bookmark: _Toc45535616][bookmark: _Toc45538343][bookmark: _Toc45538457][bookmark: _Toc46219787][bookmark: _Toc46220724][bookmark: _Toc46220839][bookmark: _Toc46930390][bookmark: _Toc47087223]Scanned Resources

· Due to COVID-19, the Library Services has made more resources available online – including negotiating access to e-content not normally available – and publishers have provided free temporary access to collections of electronic material to support teaching and research
· The Library provides detailed information on how to request digitised readings as well as the details of what is and is not allowed to be photocopied or scanned
· The resources provided by the Library are accessible and within copyright, making them the most desirable e-resources

[bookmark: _Toc45535417][bookmark: _Toc45535617][bookmark: _Toc45538344]How to make scanned or photocopied resources accessible
· If the resource contains images – even images of text – these need to have alt text provided
· Make sure that the resource is navigable and is turned the right way round
· High quality scans should not have: text that is cut off; crooked pages; dark margins; poor contrast; handwriting on the document; highlighting or underlining on the document; excessive use of script or italic fonts; or blurring
· Keep these issues in mind when picking the original document to scan, and when scanning
· Make sure the resolution is high enough (Dots per inch should be set between 300 and 400)
· Remember to push the spine of the book down whilst scanning to make sure that all of the text is copied in a clear and legible way
· Do not combine pages, as limiting each print page to one electronic page makes it easier to read and access through different platforms
· When naming the scan, be consistent, and do not use long numbers and include more than one identifier (such as the course name, the author, name of document, date, year published, etc.)

[bookmark: _Toc45535418][bookmark: _Toc45535618][bookmark: _Toc45538345]Accessible PDFs
· PDFs are inaccessible documents, as they cannot be customised by the user and they are often incompatible with assistive technologies such as screen readers as well as difficult to read on mobile phones.
· Wherever possible, publish the content of the PDF as an HTML webpage, which Blackboard Ally can then convert into alternative formats
· To create an accessible PDF, first create an accessible Microsoft Word document and then covert it into a PDF using the guidelines from Adobe
· Most older PDF documents are not fully accessible to screen readers and so cannot be used if they are essential materials
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[bookmark: _Toc45535420][bookmark: _Toc45535620][bookmark: _Toc45538347]Accessibility 
In order to provide alternative formats through Blackboard Ally, the original document/resource needs to be accessible – the copies will only be as accessible as the original. Therefore, it is important to make sure that any resources from affiliate staff or guests are accessible.

[bookmark: _Toc45535421][bookmark: _Toc45535621][bookmark: _Toc45538348]Affiliate staff
Staff should follow the HR information on the website to give relevant staff affiliate status that entitles them to a GUID and access to Office 365 and other University systems, which also allows access to Moodle. This is sufficient to create an account via LTI for Echo360 and for Medial, allowing for the download of Universal Capture for Echo360 or MediaLecture for Medial. As they will have access to Office 365 they will also have access to Teams. 

It must be noted, however, that Zoom requires a University email account and so will not be available for guests or external staff.

[bookmark: _Toc45535422][bookmark: _Toc45535622][bookmark: _Toc45538349]Guest staff
If you are inviting a guest in to deliver a limited amount of materials (one or two lectures, for example) then it is your responsibility to make sure that they are aware of the accessibility requirements for any presentations and recordings provided. It is best that these are provided in an editable format and permission given to UofG staff to create an accessible version of those files if necessary.

A guest cannot record themselves through Teams, although a UofG member of staff can press record whilst the guest is presenting, and the recording will be sent to Stream through the UofG staff member’s account. If guests record in a different system, then the recording (mp4 file) can be uploaded to Stream and a transcript will be generated there.




[bookmark: _Toc45535423][bookmark: _Toc45535623][bookmark: _Toc45538350][bookmark: _Toc45538459][bookmark: _Toc46219789][bookmark: _Toc46220726][bookmark: _Toc46220841][bookmark: _Toc46930392][bookmark: _Toc47087225]Augmented and Virtual Reality resources 

[bookmark: _Toc45535424][bookmark: _Toc45535624][bookmark: _Toc45538351]What are the regulations?
Currently, the sector is undecided on how to create accessible Virtual and Augmented Reality sources. However, there is some research that has been done which looks to help with this issue, and as the situation changes, this guidance will be updated as relevant. Please see the relevant resources in the Appendix for more information.

[bookmark: _Toc45535425][bookmark: _Toc45535625][bookmark: _Toc45538352][bookmark: _Toc45538460][bookmark: _Toc46219790][bookmark: _Toc46220727][bookmark: _Toc46220842][bookmark: _Toc46930393][bookmark: _Toc47087226]Mathematical Content

Formats such as Word, EPub3 and HTML (using MathJax to render the mathematics) have structural integrity for mathematics and are accessible to many assistive technologies (AT). A PDF with mathematical notation is not accessible to a screen reader.  However, providing a PDF file can be very useful as accessibility is not just about technical access - for some a clear or large print PDF works best.

To check that the mathematics is rendered using MathJax, which will make the equation accessible to screen readers, just right-click on the equation. The options should include ‘About MathJax’ and ‘MathJax Help’.
    
[bookmark: _Toc45535426][bookmark: _Toc45535626][bookmark: _Toc45538353]Microsoft Office Documents
· Ensure structural integrity
· All mathematical text should be written using the Equation Editor in Word (click on Insert: Equation). Even if writing a single variable x, use the editor to write this in equation format, 
· Never use Insert: Symbol
· Never write superscripts, subscripts, fractions etc. using font or style changes and standard keyboard input alone
· Never use an image of an equation

Microsoft Word provides an accessibility checker, which can be useful for highlighting any issues in the document.  In the Review tab, click on ‘Check Accessibility’. The results will appear in the right-hand document pane. Click on each error to get more information and to see the steps you should take to fix the error. Another useful option is to use Review > Read Aloud.

The accessibility checker in Excel and PowerPoint can be accessed in a similar way. In OneNote, click on View > Check Accessibility.

[bookmark: _Toc45535427][bookmark: _Toc45535627][bookmark: _Toc45538354]PDF files created from Word
The easiest way to produce an accessible PDF file is to first create an accessible Word document. Run the MS Word accessibility checker to make sure the document is free of accessibility errors. Then save as a PDF file, making sure to check the box "Document structure tags for accessibility" in the options menu. Adobe Acrobat will import accessibility attributes, such as document language, headings, alt text and table properties, upon conversion.

[bookmark: _Toc45535428][bookmark: _Toc45535628][bookmark: _Toc45538355]LaTex
 In most cases, written course material tends to be pdf files compiled from LaTex. This includes exercises and solutions in addition to lecture notes. When creating content:
· Use the \section{} commands to create a structured document. This helps create a navigable document which is compatible with screenreaders;
· Include \renewcommand{\familydefault}{\sfdefault} in the preamble to change the font family to san serif;
· All images must have a written caption that describes the content of the picture. Using the package \usepackage{axessibility} adds an automatic caption to every equation consisting of the LaTex for that equation so there is no need to manually add a caption to equations; 
· For longer PDF files, you should consider adding a table of contents before producing the HTML file. In general, several smaller files are preferable. 

The mathematical content in PDF files compiled from LaTex cannot be read by screenreaders. In order to make these accessible, we recommend that the LaTex be compiled as HTML. There are several compilers that will do this. The School of Mathematics and Statistics has tested:
1. LatexMl: For installation, you might require support from your local Learning Technologist or IT Services. For an explanation on how to compile your Tex file into HTML, see https://www.homepages.ucl.ac.uk/~ucahmto/elearning/latex/2019/06/14/latexml.html
 When compiling the HTML file, please add the package \usepackage{axessibility}. 
After the HTML is compiled, add in the lines: 
<script src="https://polyfill.io/v3/polyfill.min.js?features=es6"></script>
  <script type="text/javascript" id="MathJax-script" async  src="https://cdn.jsdelivr.net/npm/mathjax@3/es5/mml-chtml.js"> </script>
 to the <head>…</head> section of the file. 
2. Pandoc: This runs through Command Prompt or PowerShell on Windows/Terminal on Mac. For an explanation on how to compile your Tex file into HTML, see https://www.homepages.ucl.ac.uk/~ucahmto/elearning/2019/06/10/pandoc.html.

The HTML file should be uploaded to Moodle (as a file) and a link made available to students next to the original PDF file. Under “Appearance” in Settings, you should choose “Open”. 
 
[bookmark: _Toc45535429][bookmark: _Toc45535629][bookmark: _Toc45538356]R and RMarkdown
An alternative to writing documents in Latex is to write them in RMarkdown. This produces HTML with the maths equations rendered using MathJax, which is accessible and works well with assistive technologies. 

The BrailleR package can create descriptions of graphs automatically.
[bookmark: _Toc45535430][bookmark: _Toc45535630][bookmark: _Toc45538357]Mathematical Diagrams
Alt text tags (using informative text) should be added to all images and diagrams.
Sometimes diagrams can be very complex or may have a visual function designed to clarify a concept. In such instances, a text description can be unhelpful, and it is acceptable to say that the diagram is too complicated for a description. Remember that you can deliver complex information in other ways, such as creating a video, talking to students in-person, or providing a tactile alternative if appropriate.

[bookmark: _Toc45535431][bookmark: _Toc45535631][bookmark: _Toc45538358]Handwritten Notes
There is not much that one can do to make scanned handwritten notes accessible. 
You should provide an alternative format to this. We would recommend you try not to make handwritten notes the main set of lecture notes for the course. There are certain apps and software that can be used to create digital handwritten notes, such as Ink to Math in OneNote.




[bookmark: _Toc45535432][bookmark: _Toc45535632][bookmark: _Toc45538359][bookmark: _Toc45538461][bookmark: _Toc46219791][bookmark: _Toc46220728][bookmark: _Toc46220843][bookmark: _Toc46930394][bookmark: _Toc47087227]Accessibility Checkers

[bookmark: _Toc45535433][bookmark: _Toc45535633][bookmark: _Toc45538360]Microsoft Office
· Make sure to use accessibility checkers
· Accessibility checkers through Windows
· Accessibility checkers on Mac
· Check out the University’s digital accessibility website or the Microsoft website if you want more information

[bookmark: _Toc45535434][bookmark: _Toc45535634][bookmark: _Toc45538361]Blackboard Ally
· A Moodle plugin which runs within Moodle automatically to give staff accessibility guidance and to provide alternative formats for students
· The software looks for: logical heading structure using styles, PowerPoint files using layout templates for slides, font size being at least 12px, sufficient contrast between text and background, images having alternative text, tables having captions and column headers, built-in list functionality applied for lists, hyperlinked text describing the target, and tagged PDFs
· Blackboard Ally analyses Moodle resources and generates an accessibility score which is demonstrated through a red, amber, light green or dark green symbol (showing poor to perfect accessibility)

Please bear in mind these limitations when using Blackboard Ally:
· It cannot generate accessibility scores for resources contained in sub-folders of the Moodle Folder resource
· The alternative formats will only be as accessible as the original source file which you upload – what you upload needs to be accessible for Blackboard Ally to work
· The analysis does not evaluate the quality of alt text you have provided; it just checks whether it is there
· It does not flag the reading order of documents, but the Microsoft Office Accessibility Checker does


[bookmark: _Toc45535435][bookmark: _Toc45535635][bookmark: _Toc45538362][bookmark: _Toc45538462][bookmark: _Toc46219792][bookmark: _Toc46220729][bookmark: _Toc46220844][bookmark: _Toc46930395][bookmark: _Toc47087228]Appendix

[bookmark: _Toc45535436][bookmark: _Toc45535636][bookmark: _Toc45538363][bookmark: _Toc45538463][bookmark: _Toc46219793][bookmark: _Toc46220730][bookmark: _Toc46220845][bookmark: _Toc46930396][bookmark: _Toc47087229]Guidance for Students

How to support your learning with transcripts/captions of video recordings
You may have access to recordings of lectures and other teaching as part of your course. This guidance is in addition to other guidance given on how to make the most of lecture recordings.

To provide a more accessible, flexible and inclusive learning experience the University is providing transcripts and/or captions for video recordings. Having written text may help you understand what is said in the recordings and may make it easier to navigate through recorded material.
[bookmark: _Toc45535438][bookmark: _Toc45535638][bookmark: _Toc45538365]What to expect from transcripts and captions
· Transcripts will be automatically generated and may not have been checked by a lecturer before being provided to you
· Speech-to-text technology is still developing so it is important to note that automated transcripts and captions will not always be exactly the same as what is said in the recording
· Auto transcripts vendors claim that their products are between 80-90% accurate. Strong anecdotal experience suggests a lower figure is applicable in many circumstances
· Transcript accuracy will vary from recording to recording and will depend on many factors, including the quality of each audio recording and the ability of the machine to recognise the voice
· We recommend that if one is available, you use a subject-specific dictionary which should help you identify key terms. These are likely to be required in some subjects more than others. Examples include subjects such as maths and medicine, which use specific and technical terminology
· Key words and formulae may be available on the slides provided in advance of the lecture recording being available
[bookmark: _Toc45535439][bookmark: _Toc45535639][bookmark: _Toc45538366]How to use transcripts and captions to support your learning
· Transcripts can be searched to find a specific place in a recording, providing an efficient way to locate what you are looking for
· Captions will allow recordings to be viewed in locations where audio is not possible
· Do not expect transcripts or captions to be completely accurate; check your understanding using other sources such as textbooks, a subject specific dictionary or lecture slides
· If you are unsure about something in the recorded lecture, please contact the lecturer and ask questions to clarify your understanding
[bookmark: _Toc45535440][bookmark: _Toc45535640][bookmark: _Toc45538367]Feedback 
· The University is keen to hear your feedback on the usefulness of the transcripts and captions provided and will use that feedback to make improvements
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[bookmark: _Toc45535442][bookmark: _Toc45535642][bookmark: _Toc45538369]University Guidelines:
Digital accessibility webpages
https://www.gla.ac.uk/myglasgow/digitalaccessibility/
Writing for the web
https://www.gla.ac.uk/myglasgow/staff/webpublishing/design/writingfortheweb/writingforthewebguidelines/

[bookmark: _Toc45535443][bookmark: _Toc45535643][bookmark: _Toc45538370]UK.GOV resources
The Public Sector Bodies (Websites and Mobile Applications) (No. 2) Accessibility Regulations 2018
http://www.legislation.gov.uk/uksi/2018/852/contents/made
Understanding accessibility requirements for public sector bodies
https://www.gov.uk/guidance/accessibility-requirements-for-public-sector-websites-and-apps
Websites and apps requirements
https://www.gov.uk/guidance/accessibility-requirements-for-public-sector-websites-and-apps
18F Accessibility Guide
https://accessibility.18f.gov/checklist/
Accessible PDFs
 https://www.gov.uk/guidance/how-to-publish-on-gov-uk/accessible-pdfs

[bookmark: _Toc45535444][bookmark: _Toc45535644][bookmark: _Toc45538371]JISC
Meeting accessibility guidelines
https://www.jisc.ac.uk/accessibility
Background information regarding digital accessibility
https://www.jisc.ac.uk/news/we-must-embrace-technology-to-make-education-easier-fairer-and-more-inclusive-10-mar-2020
https://www.jisc.ac.uk/guides/embedding-blended-learning-in-further-education-and-skills
https://www.jisc.ac.uk/guides/using-assistive-and-accessible-technology-in-teaching-and-learning/alternative-formats
https://www.jisc.ac.uk/guides/enhancing-the-digital-experience-for-skills-learners/resources-for-developing-staff-digital-capabilities
Advice for meeting the requirements of specific learners
https://www.jisc.ac.uk/blog/top-tools-to-help-your-dyslexic-learners-16-oct-2013
https://www.jisc.ac.uk/guides/meeting-the-requirements-of-learners-with-special-educational-needs/dyslexia
https://www.jisc.ac.uk/guides/meeting-the-requirements-of-learners-with-special-educational-needs/visual-impairments

[bookmark: _Toc45535445][bookmark: _Toc45535645][bookmark: _Toc45538372]Policy Connect 
(accessibility in VLEs)
https://www.policyconnect.org.uk/appgat/research/accessible-vles-making-most-new-regulations

[bookmark: _Toc45535446][bookmark: _Toc45535646][bookmark: _Toc45538373]VLE specific
https://www.ed.ac.uk/information-services/help-consultancy/accessibility/creating-materials/accessiblevlecontent

[bookmark: _Toc45535447][bookmark: _Toc45535647][bookmark: _Toc45538374]W3C
Web Content Accessibility Guidelines (WCAG) 2.1
https://www.w3.org/TR/WCAG21/
Accessibility standards
https://www.w3.org/standards/webdesign/accessibility
Web Accessibility Evaluation Tools List
 https://www.w3.org/WAI/ER/tools/
Easy website checks
https://www.w3.org/WAI/test-evaluate/preliminary/
Forms accessibility tutorial
https://www.w3.org/WAI/tutorials/forms/
Before and after
https://www.w3.org/WAI/demos/bad/

[bookmark: _Toc45535448][bookmark: _Toc45535648][bookmark: _Toc45538375]Software help
LaTex, Tex4ht, and MathML guidance
http://www.csun.edu/~hcmth008/mathml/acc_tutorial.pdf
MathML information
https://www.washington.edu/doit/what-mathml
Blogs on software for equations in Moodle
https://blog.ucem.ac.uk/onlineeducation/posts/1567
https://blog.ucem.ac.uk/onlineeducation/posts/1276
MathType
https://docs.wiris.com/en/mathtype/mathtype_web/accessibility
Making maths accessible
http://diagramcenter.org/accessible-math-tools-tips-and-training.html
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